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1. What’s New with DWR’s? 

2. Create a DWR to record placed quantities 
 
Login 
Username: Uxxxx Password: xxxxx Role: INSPECTOR 
 
Navigation 
Inspector Links>Daily Work Report  
 
1. Click the Component Action button and Select Contract to Add DWR  
2. Check the Contract ID 07817A Milk River - North row. 
3. Scroll to the bottom right and click on the Create DWR on Contract button. 
4. Click Save. 
5. Verify that the DWR Date and Inspector fields are auto-populated with the current date 

and user. 
6. From the Weather AM dropdown list, select Clear - Clear 
7. From the Weather PM dropdown list, select Cloudy – Cloudy  
8. In the Low Temperature field, type 60  
9. In the High Temperature field, type 80 
10. In the Rainfall Amount field, type 0 
11. Scroll down to the Remarks Section 
12. From the Type dropdown list select the DWRCrew _Crew Activity  
13. In the Remarks field type Cold milling  
14. In the next remarks row select the DWRWeather - Weather from the Type dropdown 

list. 
15. In the Remarks field, type No weather issues for today 
16. Click the Save button 
17. Click on the Contractors Tab 
18. Click on the Select Contractors button 
19. Click on Vendor ID 6013 - INDUSTRIAL BUILDERS INC. 
20. Click on the Add to DWR Contractors button 
21. Click on the Start Time Calendar icon 
22. Select the current date at 08:00 AM 
23. Click on the Start Time Calendar icon to close the window 
24. Click on the End Time Calendar icon 
25. Select the current date at 05:00 PM 
26. Click on the End Time Calendar icon to close the window 
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27. Type in 8 in the Hours field 
28. Click the Save button. 
29. Verify that the fields Equipment, Personnel, Staff and DBE Certified are all auto-

populated with No. 
30. Click on the Contractor Equipment Tab 
31. Click on the Contractor Row Actions button and Select Equipment link 
32. Select Pickup and Wirtgen 220i Cold Milling Machine from the list 
33. Click on the Add to DWR Contractor Equipment button 
34. For the Pickup row, In the Number On Site field, type 2 
35. For the Pickup row, In the Number Used field, type 2 
36. For the Pickup row, In the Hours Used field, type 8 
37. For the Pickup row, In the Comments field, Type 2 GMC Crew cabs 
38. For the Wirtgen 220i Cold Milling Machine row, In the Number On Site field, type 1 
39. For the Wirtgen 220i Cold Milling Machine row, In the Number Used field, type 1 
40. For the Wirtgen 220i Cold Milling Machine row, In the Hours Used field, type 7 
41. Click the Save button 
42. Click on the Contractor Personnel Tab 
43. Click on the Contractor Row Actions button and Select Personnel link 
44. Select Truck Drivers from the list 
45. Click on the Add to DWR Contractor Personnel button 
46. In the Truck Drivers row, In the Number On Site field, type 2 
47. In the Truck Drivers row, In the Total Hours field, type 8 
48. In the Truck Drivers row, In the Decision Class field type truck and select Truck Driver – 

Zone 2 from the list 
49. Click Save 
50. Select the Contractor Staff Tab 
51. Click on the Contractor Row Actions button and Select Staff link 
52. Select Myers, Brian from the list 
53. Click on the Add to DWR Contractor Staff button 
54. In the Number On Site field, type 1 
55. In the Total Hours field, type 9 
56. Click the Save button 
57. Click on the Work Items Tab 
58. Click the Select Items button 
59. In the Search field, type cold    
60. Select Proj Item Ln Num 0110 Project/Category 9028052000[x]/0001 Item/Description 

411010000 - COLD MILLING from the list 
61. Click the Save button 
62. Click on the Item Row Action button and select New Posting  
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63. Verify that INDUSTRIAL BUILDERS, INC is auto-populated in the Contractor field 
64. In the Placed Quantity field, type 1216.5 
65. In the Station From field, type 30+00 
66. From the Offset Type dropdown list, select RT 
67. In the Offset Distance field, type 23 FT 
68. In the Station To field, type 59+8.45 
69. In the Location/Description field, type Mill – East Bound driving lane 
70. In the Material Set field verify that No Materials is auto-populated 
71. Click the Save button 
72. Verify that Tot Qty Posted to Dt is auto-populated with 1216.500 
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3. Create a DWR to calculate quantities in an agency view 
 
Login 
Username: Uxxxx Password: xxxxx Role: INSPECTOR 
 
Navigation 
Daily Work Report Overview 
 
1. From the component action menu, choose Add New. 
2. Verify that the DWR Date and Inspector fields are auto-populated with the current date 

and user. 
3. Click Save. 
4. Scroll down to the Remarks Section 
5. From the Type dropdown list select the DWRCrew _Crew Activity  
6. In the Remarks field type Traffic Control  
7. Click the Save button 
8. Click on the Contractors Tab 
9. Click on the Select Contractors button 
10. Click on Vendor ID 2096 SK Construction. 
11. Click on the Add to DWR Contractors button 
12. Click on the Start Time Calendar icon 
13. Select the current date at 7:00 AM 
14. Click on the Start Time Calendar icon to close the window 
15. Click on the End Time Calendar icon 
16. Select the current date at 5:00 PM 
17. Click on the End Time Calendar icon to close the window 
18. Type in 10 in the Hours field 
19. Click the Save button. 
20. Click on the Work Items Tab 
21. Click the Select Items button 
22. In the Search field, type traffic 
23. Select Proj Item Ln Num 0140 Project/Category 9028052000[x]/0001 Item/Description 

6180300005 – TRAFFIC CONTROL CB from the list 
24. Click the Save button 
25. Click on the Item Row Action button and select New Posting  
26. Verify that SK CONSTRUCTION is auto-populated in the Contractor field 
27. Expand the Item by clicking on the >. 
28. In the station from field enter 20+00 
29. In the station to field enter 50+00. 
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30. Click Save 
31. Expand the Item by clicking on >. 
32. On the Row Action menu, click on MDT Traffic Control 
33. In the Unit System field, select English. 
34. Click the New button.  
35. In the Station/Location field, enter 20+00. 
36. In the TC Layout field, enter Trucks Entering. 
37. In the Install type, select Install 
38. In the Group field, select 34-1 Flagger -Zone 1. 
39. In the Start Hour field, enter 07. 
40. In the Mins field, enter 00. 
41. In the Stop Hour field, enter 17. 
42. In the Mins field, enter 00. 
43. In the No of Items field, enter 1 
44. Click the New button.  
45. In the Station/Location field, enter 25+00. 
46. In the Install type, select Install 
47. In the Group field, select 01-Portable Mount Signs 
48. In the No of Items field, enter 12 
49. Click Save 
50. Verify that the placed quantity in the header is 812. 
51. Click on the DWR Item Posting Quick Link 
52. Expand the Item by clicking on the > 
53. The placed quantity will be auto populated with 812. 

  



MONTANA DEPARTMENT OF TRANSPORTATION 
AASHTOWare Project Construction and Materials 

 
 

INSPECTOR.docx Updated 9-13-18 Help Desk 1-877-406-4338 Page 8 of 35 

4. Create a DWR for Visual Inspection acceptance 
 
Login 
Username: Uxxxx Password: xxxxxx Role: INSPECTOR 
 
Navigation 
Contract Daily Work Report Summary 

 
1. Click on Work Items Tab 
2. Click Select Items button 
3. Type curb in the Search field 
4. Select Project Line Item 0570 – 609010200-CURB AND GUTTER-CONC from the list 
5. Click the Save button 
6. Click on the Item Row Action button and select New Posting 
7. In the Contractor field verify that SK CONSTRUCTION, INC. (Prime) is auto-populated 
8. In the Placed Quantity field, type 2 
9. In the Station From field, type 118+07 
10. In the Station To field, type 134+07 
11. In the Location/Description field, type Curb & Gutter 
12. From the Material Set field, Select Class General-Optimized  
13. Click Save. 
14. Click on the Acceptance Records Tab 
15.  Expand the Curb & Gutter section by clicking on the > arrow 
16. Expand the 713.01.00.01 - Water section by clicking  the > arrow  
17. Hit enter in the Source ID field and select City of Great Falls from the list 
18. From Field Inspection Value dropdown list, select INSPECT – Visually Inspected 
19. From the Material has been visually inspected dropdown list select Acceptable 
20. In the Comments field type Visual inspection of water added to concrete truck 
21. Click Save 
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5. Run the DWR Report 
 
Login 
Username: Uxxxx Password: xxxxxxx Role: INSPECTOR 
 
Navigation 
Home > Daily Work Report Overview > 07817A 
 
 
1. Look for the current date DWR under your Inspector name 
2. Click on the Row Action button and select DWR Report under Reports 
3. Click the Execute button 
4. Verify the report is displayed in a new Internet Explorer window 
5. Click File > Save as… 
6. Browse to your team folder 
7. Change the File name to DWRReport.pdf 
8. Click Save 
9. Close the Internet Explorer window 
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6. Submit the DWR for Approval 
 
Login 
Username: Uxxxx Password: xxxxx Role: INSPECTOR 
 
Navigation 
Home > Daily Work Report Overview > 07817A 
 
 
1. Look for the current date DWR under your Inspector name 
2. Click on the Date link to open the DWR 
3. Click on the Component Action button and select Submit for Approval 
4. Verify that the Status changes from Draft to Pending Approval in the status bar  
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7. Create a DWR to record a correction 
 

Login 
      Username: Uxxxx Password: xxxxx Role: INSPECTOR 
 

Navigation 
Daily Work Report Overview 
1. Click the Component Action button and select Add New. 
2. Verify that the Inspector field is auto-populated with the user. 
3. Click Save 
4. Scroll down to Remarks Section. 
5. From the Type dropdown List select DWRCorrection – Correction 
6. Type Correction on original DWR (Sequence 1).  Quantity should have been entered on 

project 5157 item instead of 9028.  in the Remarks window. 
7. Click Save. 
8. Click on the Contractors Tab 
9. Click on the Select Contractors button 
10. Click on Vendor ID 6013 - INDUSTRIAL BUILDERS INC 
11. Click on the Add to DWR Contractors button 
12. Click Save 
13. Click on the Work Items Tab 
14. Click the Select Items button 
15. Type cold in the Search field 
16. Select both Proj Item Ln Num 0110 and Project Line Item 0290 – 411010000 - COLD 

MILLING from the list 
17. Click the Save button 
18. Click on the Project Line Item 0110 Row Action button and select New Posting  
19. In the Contractor field, select INDUSTRIAL BUILDERS INC  
20. In the Placed Quantity field type -1216.50  
21. In the Location/Description field type Quantity should have been entered on project 

5157 instead of 9028 
22. In the Material Set field verify that No Materials is auto-populated  
23. Click the Save button 
24. Click the Select Items button 
25. Type cold in the Search field 
26. Click on the Project Line Item 0290 Row Action button and select New Posting  
27. In the Contractor field, select INDUSTRIAL BUILDERS INC  
28. In the Placed Quantity field type 1216.50 
29. In the Location/Description field type Correction  
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30. In the Material Set field verify that No Materials is auto-populated  
31. Click the Save button 

8. Create a force account 
 
Login 
Username: Uxxxx Password: xxxxxx Role: INSPECTOR  
 
Navigation 
Inspector Links > Contract Progress > 07817A > Force Accounts 
 
 
1. Click the New button 
2. In the Descr field, Enter Place riprap in eroded trench in 12+20 RT 
3. Click Save 
4. Click on the linked Seq Num 1 to open the force account 
5. Click on the Contractors tab 
6. Click on the Select Contractors button 
7. In the search field, click enter 
8. Choose 2096 SK CONSTRUCTION, INC.  
9. Click the Add to Force Account Contractors button 
10. Click Save 
11. Click on the 2096 Vendor link 
12. Verify Equipment Pct field is auto-populated with 10.000 percent  
13. Verify Labor Pct field is auto-populated with 80.000 percent 
14. Verify Materials Pct field is auto-populated with 15.000 percent 
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9. Input the necessary information into the Force Account 
 
Login 
Username: Uxxxx Password: xxxxxx Role: INSPECTOR 
 
Navigation 
Continuation from previous test case 
 
1. Click on the Equipment tab 
2. Click the Select Force Account Contractor Vendor Equipment button 
3. Scroll down and check Pickup  
4. Click on the Add to Force Account Contractor button 
5. In the Supp Descr field, enter 2000 GMC 
6. In the Standard Hourly Rate field, enter 14.51 
7. In the Idle Hourly Rate field enter 0.00 
8. In the Own Type dropdown list, select Owned 
9. Click Save 
10. Click on the Labor tab 
11. Click Select Force Account Contractor Labor button 
12. Check the Laborers personnel type 
13. Click on the Add to Force Account Contractor button 
14. In the Supp Descr field, enter Sawyer Smith 
15. In the Regular Hourly Rate field, enter 30.02 
16. In the OT Hourly Rate field enter 45.03 
17. Click Save 
18. Click Select Force Account Contractor Labor button 
19. Check the Laborers personnel type 
20. Click on the Add to Force Account Contractor button 
21. In the Supp Descr field, enter Madison James 
22. In the Regular Hourly Rate field, enter 30.02 
23. In the OT Hourly Rate field enter 45.03 
24. Click Save 
25. Click on the Material Invoices tab 
26. Click New 
27. In the Descr field, enter 4" to 6" boulders. 
28. In the Date calendar popup, Select 4/06/2018 
29. In the Amount field, enter 10.50 
30. In the Qty field, enter 0.81 
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31. In the Unit Price field, enter 12.96 
32. In the Units dropdown list, select TON - Ton 
33. Click Save 
34. Click on the Miscellaneous Invoices tab 
35. Click New 
36. In the Descr field, enter Premium on bond 
37. In the Amount field, enter 5.75 
38. Leave other remaining fields blank 
39. Click Save 
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10. Create DWR to record Force Account 
 
Login 
Username: Uxxxx Password: xxxxx Role: INSPECTOR 
 
Navigation 
Home > Inspector Links>Daily Work Report 
 
 
1. Click on the Component Action button and click on Select Contract to Add DWR 
2. Click on 07817[X] 
3. Click the Create DWR on Contract button 
4. Click Save 
5. Click on the Force Account Contractor tab 
6. Click on Select Force Account Contractors 
7. Select Seq Num 1 - Place riprap in eroded trench in 12+20 RT 
8. Click on Add to DWR Force Acct Contrs 
9. Click Save 
10. Click on 1 under Seq Num 
11. Enter 5.0 under Std hrs  
12. Leave Idle hrs blank. 
13. Click on the Labor tab 
14. Enter 5.0 under the Reg Hrs for both employees.  
15. Leave OT Hrs blank 
16. Click on the Materials tab 
17. Enter 0.81 under Qty 
18. Click Save 
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11. Complete a Force Account and run report 
 
Login 
Username: Uxxxx Password: xxxxxx Role: INSPECTOR 
 
Navigation 
Contract Progress  
 
 
1. Click on the Contract Progress quick link 
2. Click on the Force Accounts tab 
3. Click on 1 under Seq Num 
4. Click on the checkbox under Complete 
5. Click on Save 
6. Click on the arrow next to Save 
7. From the row action menu, click on Force Account Report 
8. Leave the Start Date and End Date blank 
9. Click Execute 
10. A dialog box will appear at the bottom of the screen, asking if you want to Open, Save, 

or Cancel. 
11. Select Open 
12. Review the Force Account Report 
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12. What’s New with Sample Records? 

13. Create a sample record for Class Deck concrete 
that is routed through the district lab 

 
Login 
Username: Uxxxx Password: xxxxx  Role: INSPECTOR 
 
Navigation 
Inspector Links > Sample Records 
 
 
1. Click on the Component Action button and select Add 

2. In the Material Code – Name field, type deck and select 551.03.02.06 Class Deck 
Concrete 

3. Select the current date in the Sample Date calendar popup 

4. In the Sample Type dropdown, select PROJ – Project Acceptance  

5. In the Acceptance Method dropdown, select TEST – Test Results  

6. Click Save 

7. Confirm the Lab Control Number and Created Date are auto-populated 

8. Confirm the Sample Status of Pending is auto-populated 

9. In the Witnessed By ID - Name field, enter your last name and select your name 

10. In the Specimen(s) Number field, enter L4T1_13-16   

11. In the Intended Use field, enter Yellowstone River NB 

12. In the District/Area field, select BOZ - Bozeman 

13. In the Control Type dropdown, select LOT - Lot Number  

14. In the Control Number field, enter 4 

15. Click Save 

a. To tester – note the last four digits of the Sample ID or the Id number – this will 
be used multiple times in later test cases 

16. Click on the Sources tab 

17. Click the Select Primary Source button  

18. In the search field, hit Enter 
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19. Select HighCaliberConc – High Caliber Concrete  

20. Click the Add to Sample Record button 

21. Click Save 

22. Click on the Destination Lab(s) tab  

23. Click the New button 

24. Verify the Destination field auto-populated to Destination Lab 

25. Click in the Lab Name field and enter field 

26. Select FieldCrew 

27. Click the New button  

28. Click in the Lab Name field and hit Enter 

29. Select Butte Receiving 

30. Click Save 

31. Click on the Contract tab  

32. Click on the Select Contract Project Items button 

33. In the search field, type 07817[x]   

34. Click on 0800 – CONCRETE-CLASS DECK, Class Deck-Optimized 

35. Click Save 

36. Click the > arrow to expand the Contract Project Item 

37. In the Represented Quantity field, enter 5.2 

38. Click Save 

39. Click on the Tests tab  

40. Click on the arrow to the right of the Assign Tests button and select Assign Default 
Tests 

41. Verify the tests ConcreteProperties and District_Received are added 

42. Click the Home button 
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14. Enter test results for the Class Deck concrete 
sample Concrete Properties tests  

Login 
Username: Uxxxx Password: xxxxx Role: INSPECTOR 
 
Navigation 
Inspector Links > Enter Test Results 
 
 
1. Under the Tests section, in the search field enter the last 4 digits of the Sample ID or the 

Id number 

2. On the ConcreteProperties test row, click on the Test Number 1.0 link 

3. Click on the Testers tab 

4. Click New 

5. In the Tester ID field, type your last name and select your name 

6. Click Save 

7. Click on the Reference Specifications tab 

8. Check the Use for Test checkbox 

9. Click Save 

10. Click on the Component Action button and select MDT Concrete Properties under 

Views 

11. In the Lot # field, enter 4 

12. Check the Performed with the cylinder samples checkbox 

13. Enter the concrete data according to the following: 
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14. Click Save 

15. Verify that the Slump Difference auto-calculated to -0.5 

16. Verify that the Temperature field is Out of Spec 

17. In the Test Result Value field, hit Enter and select Fail  

18. Click Save 

19. Click the Sample Record Test Quick Link 

20. Scroll down the page and verify that the Test Result Value field is auto-populated to Fail 

- Fail  

21. Click on the Component Action button and select Mark Test Complete 

22. Click the Home button 
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15. Other Examples of DWR’s and Samples 

16. Create a Daily Work Report and post quantity to an 
emulsion bid item 

 
Login 
Username: Uxxxx Password: xxxxx Role: INSPECTOR 
 
Navigation 
Dashboard > Daily Work Report Overview  
 
 
1. Click on the Action button and Select Contract to Add DWR… 
2. Click on contract 07817[X] MILK RIVER – NORTH 
3. Click on the Create DWR on Contract button 
4. Verify the DWR Date and Inspector auto-populate 
5. Click the Save button 
6. Click on the Contractors Tab 
7. Click the Select Contractors button 
8. Click on Vendor 2096 SK CONSTRUCTION, INC 
9. Click the Add to DWR Contractors button 
10. Click the Save button 
11. Click on the Work Items Tab 
12. Click the Select Items button 
13. Type crs in the Search field 
14. Click on Proj Item Ln Num 0080 - 402020368-EMILSIFIED ASPHALT CRS-2P 
15. Click the Save button 
16. Click on the Row Actions button and select New Posting 
17. Verify SK CONSTRUCTION, INC. is selected in the Contractor field.  
18. In the Placed Quantity field, enter 0.50 
19. In the Station From field, enter 150+7 
20. From the Material Set dropdown verify CRS-2p is auto-populated 
21. Click the Save button 
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17. Enter material acceptance information into a DWR 
acceptance record - emulsion 

Login 
Username: Uxxxx Password: xxxxxx Role: INSPECTOR 
 
Navigation 
Based on previous test case 
 
 
1. Click on the Acceptance Records Tab 
2. Click on the > icon to expand the row 
3. Hit enter in the Source ID field and select Calumet Montana Refining LLC  
4. From the Field Inspection Value dropdown select EMULS – Emulsion Sample 

Witnessed 
5. From the Witnessed calendar popup Select current date 
6. In the Invoice # field Enter 45678 
7. From the Sample Type dropdown select PROJ – Project Acceptance 
8. From the Acceptance Method dropdown select TEST – Test Results 
9. In the Comments field enter 1-1A 
10. Click the Save button 
11. Click on the > arrow to Expand the section 
12. Click on the Material Row Action button and select Attachments 
13. Click the Select File button 
14. Browse to folder and select CRS 2-P Invoices.pdf 
15. Click Open 
16. Enter Bill of Lading / Certificate of Compliance in the Description field 
17. Click Save 
18. Click Previous button 
19. Click on the Acceptance Records Tab  

  



MONTANA DEPARTMENT OF TRANSPORTATION 
AASHTOWare Project Construction and Materials 

 
 

INSPECTOR.docx Updated 9-13-18 Help Desk 1-877-406-4338 Page 23 of 35 

18. Create a sample record for the emulsion material 
 
Login 
Username: Uxxxx Password: xxxxxx Role: INSPECTOR 
 
Navigation 
Based on previous test case 
 
 
2. Click on the > icon to expand the Emulsified Asphalt CRS-2P row 
3. From the Row Action button select Create New Sample Record 
4. From the Administrative Office list select Crew 4183 
5. Click the Save button 
6. Verify that the following fields were auto-populated in the General Tab on the sample 

record from the DWR acceptance record 
a. Material Code – 702.01.06.02 
b. Sample Date – Current date 
c. Sample Type – PROJ – Project Acceptance 
d. Acceptance Method – TEST – Test Results 

7. Click on the Additional Information Tab 
8. Verify that the person ID is auto-populated in the DWR Inspector field 
9. Click on the Sources Tab 
10. Verify Calumet Montana Refining LLC is listed in the Source ID 
11. Click on the Contract Tab 
12. Click on the > icon to expand the row 
13. Verify that contract item 42020368-Emulsified Asphalt CRS-2P with Material Set CRS-2p 

is auto-populated 
14. Click on the Destination Lab(s) Tab 
15. Click the New button 
16. In the Lab Name field type butte and select Butte Receiving  
17. Click the Save button 
18. Click on the Tests Tab 
19. Click the arrow button to the right of the Assign Tests button and select Assign Default 

Tests 
20. Verify Test 1.0 District_Received in the Butte Lab is added 
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19. Add custom equipment to a Daily Work Report 
 
Login 
Username: Uxxxx Password: xxxxx Role: INSPECTOR 
 
Navigation 
Daily Work Report Overview 
 
 
1. Click on the Component Action button and select Select Contract to Add DWR 
2. Click on the 07817[x] Contract ID row 
3. Click on the Create DWR on Contract button 
4. Click Save 
5. Click on the Contractors Tab 
6. Click on the Select Contractors button 
7. Click on the 2096 SK CONSTRUCTION, INC. row 
8. Click the Add to DWR Contractors button 
9. Click Save 
10. Click on the Contractor Equipment Tab 
11. Click on the Row Action button and select Select Equipment 
12. Click on the Caterpillar Grader 140H and Caterpillar Excavator 225F rows 
13. Click the Add to DWR Contractor Equipment button 
14. Enter 1 in the Number on Site field for both rows 
15. Enter 1 in the Number Used field for both rows 
16. Enter 8 in the Hours Used field for both rows 
17. Click Save 
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20. Add custom personnel to a Daily Work Report 
 
Login 
Username: Uxxxx Password: xxxxxx Role: INSPECTOR 
 
Navigation 
Continuation from previous test case 
 
 
1. Click on the Contractor Personnel Tab 
2. Click on the Row Action button and Select Personnel 
3. Click on the Smith, Joe (Detour Maintenance Worker) and Stone, Kelly (On-the-job 

laborer trainee) rows 
4. Click the Add to DWR Contractor Personnel button 
5. In the Number on Site enter 1 field for both rows 
6. in the Total Hours field enter 8 field for both rows 
7. In the Decision Class field type labor and select Laborer – Zone 1 field for both rows 
8. Click Save 
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21. Add custom staff(supervisors) to a Daily Work 
Report 

 
Login 
Username: Uxxxx Password: xxxxxx Role: INSPECTOR 
 
Navigation 
Continuation from previous test case 
 
 
1. Click on the Contractor Staff Tab 
2. Click on the Row Action button and Select Staff 
3. Click on the Jones, Gary row 
4. Click the Add to DWR Contractor Equipment button 
5. In the Number on Site field enter 1  
6. In the Total Hours field enter 9  
7. Click Save 
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22. Create a DWR to record visual inspection of 
wood/timber product on the project 

Login 
Username: Uxxxx Password: xxxxxx Role: INSPECTOR 
 
Navigation 
Daily Work Report Overview 
 
 
1. Click on the Component Action button and select Select Contract to Add DWR   
2. Check the Contract ID 07817[X] row   
3. Click the Create DWR on Contract 
4. Click Save 
5. Click on the Contractors tab 
6. Click the Select Contractors button.   
7. Check the Vendor ID 2096 SK CONSTRUCTION, INC. row 
8. Select Add to DWR Contractors button 
9. Click Save 
10. Click on the Work Items tab 
11. Click the Select Items button   
12. Enter wood in the Search field 
13. Check the Proj Ln Itm Nbr 0250 - 619010480 - POLES-TREATED WOOD 4 IN row 
14. Click the Save button 
15. Click the Row Action button and select New Posting 
16. Enter 100 in the Placed Quantity field 
17. Enter Signing in the Location/Description 
18. Verify that Fence Post is auto-populated in the Material Set field 
19. Click Save 
20. Click on the Acceptance Records tab 
21. Click on the > to expand the DWR Acceptance record  
22. Select VIS - Visual Inspection from the Action Type dropdown list 
23. Select INSPECT – Visually Inspected from the Field Inspection Value dropdown list 
24. Select Acceptable from the Material has been visually inspected dropdown list 
25. Select Marks-Miller Post and Pole Inc. from the Source ID list 
26. Select 1909B from the Product Name/Seal#/Batch/Lot field 
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27. Enter 1918B in the Comments field 
28. Click Save 
 
 
 

23. Create a DWR to record visual inspection of seed 
on the project 

Login 
Username: Uxxxx Password: xxxxx Role: INSPECTOR 
 
Navigation 
Daily Work Report Overview  
 
 
1. Enter 07817[X] in the Search field 
2. Click on the current date of the DWR with your name under the Inspector column 
3. Click on the Work Items tab 
4. Click the Select Items button.   
5. Enter seed in the Search field 
6. Check the Proj Ln Itm Nbr 0600 - 610100101-SEEDING AREA NO 1 row 
7. Click the Save button 
8. Click the Row Action button and select New Posting 
9. Enter 55 in the Placed Quantity field 
10. Enter Seeding Area 1 in the Location/Description 
11. Verify that Seed is auto-populated in the Material Set field 
12. Click Save 
13. Click on the Acceptance Records tab 
14. Click on the > to expand the DWR Acceptance record  
15. Select VIS - Visual Inspection from the Action Type dropdown list 
16. Select INSPECT – Visually Inspected from the Field Inspection Value dropdown list 
17. Select Acceptable from the Material has been visually inspected dropdown list 
18. Select Treasure State Seed Company from the Source ID list 
19. Select Seed Batch 1234 from the Product Name/Seal#/Batch/Lot field 
20. Click Save 
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24. Create a DWR to record visual inspection of the 
precast item on the project  

 
Login 
Username: Uxxxx Password: xxxxxx Role: INSPECTOR 
 
Navigation 
Daily Work Report Overview  
 
 
1. Enter 07817[X] in the Search field 
2. Click on the current date of the DWR with your name under the Inspector column 
3. Click on the Work Items tab 
4. Click the Select Items button.   
5. Enter rcp 18 in the Search field 
6. Check the Proj Ln Itm Nbr 0350 - 603012535 - RCP 18 IN CLASS 3 row 
7. Click the Save button 
8. Click the Row Action button and select New Posting 
9. Enter 50 in the Placed Quantity field 
10. Enter Reinforced Concrete Pipe in the Location/Description 
11. Verify RCP is auto-populated in the Material Set dropdown field 
12. Click Save 
13. Click on the Acceptance Records tab 
14. Click on the > to expand the DWR Acceptance record  
15. Select VIS - Visual Inspection from the Action Type dropdown list 
16. Select STL – Steel Cert Reviewed from the Field Inspection Value dropdown list 
17. Select Meets Specs from the Certification comparison to MDT Specs dropdown list 
18. Select Meets Specs from the Form 406 dropdown list 
19. Select Forterra Pipe & Precast (Cretex)-Helena #67 from the Source ID list 
20. Select Precast Conc Pipe from the Product Name/Seal#/Batch/Lot field 
21. Click Save 
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25. Create a DWR to record visual inspection of the 
beam on the project 

Login 
Username: Uxxxx Password: xxxxxx Role: INSPECTOR 
 
Navigation 
Materials > Daily Work Reports 
 
 
1. Enter 07817[X] in the Search field 
2. Click on the current date of the DWR with your name under the Inspector column 
3. Click on the Work Items tab 
4. Click the Select Items button.   
5. Enter pre in the Search field 
6. Check the Proj Ln Itm Nbr 0840 - 553010157 - PRESTRESSED BEAM-TYPE MTS-63 

row 
7. Click the Save button 
8. Click the Row Action button and select New Posting 
9. Enter 1 in the Placed Quantity field 
10. Enter Beam01 in the Location/Description 
11. Verify that Prestressed Beam is auto-populated in the Material Set field 
12. Click Save 
13. Click on the Acceptance Records tab 
14. Click on the > to expand the DWR Acceptance record  
15. Select VIS - Visual Inspection from the Action Type dropdown list 
16. Select STL – Steel Cert Reviewed from the Field Inspection Value dropdown list 
17. Select Meets Specs from the Certification comparison to MDT Specs dropdown list 
18. Select Meets Specs from the Form 406 dropdown list 
19. Select Forterra Pipe & Precast (Cretex) Billings #61 from the Source ID list 
20. Select Beam01 from the Product Name/Seal#/Batch/Lot field 
21. Click Save 
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26. Create an aggregate sample record that is routed 
through the district lab 

Login 
Username: Uxxxx Password: xxxxxx  Role: INSPECTOR 
 
Navigation 
Inspector Links > Sample Records 
 
 
1. Select the dropdown menu and click Add. 

2. From the Sample Date calendar popup select the current date.  

3. In the Material Code – Name field enter bedding. 

4. Select 701.04.01.01 (Bedding Material).  

5. Select PROJ – Project Acceptance from the Sample Type dropdown menu.  

6. Enter 21148 in the Lab Reference Number field.  

7. Select TEST – Test Results from the Acceptance Method dropdown menu.  

8. Click Save.  

9. Verify that the Lab Control number, Created Date, and Sample Status are auto-
populated.  

10. **MAKE note of the last 4 digits of the Sample ID or the Id itself to use in later test cases 

11. Begin typing your last name into the Witnessed By ID – Name field  

12. Select your name from the list 

13. Enter 1-2 in the Specimen(s) Number field 

14. Type Sample for proctor testing in the Intended Use field 

15. Select BOZ - Bozeman from the District/Area dropdown menu 

16. Click Save   

17. Click on the Sample Location tab  

18. Enter Stockpile in the Sampled From field  

19. Click the Save button  

20. Click on the Sources tab  

21. Click the Select Primary Source button  

22. Begin to type sterling into the search bar  

23. Select 31-001140 – Sterling Ranch Pit 
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24. Click the Add to Sample Record button.  

25. Click Save 

26. Click on the Destination Lab(s) tab.  

27. Click on the New button underneath the search bar.  

28. Select Destination Lab from the Destination dropdown menu.  

29. Begin to type bozeman into the Lab Name field to initiate search.  

30. Select Bozeman Receiving.  

31. Click the Save button.  

32. Click on the Contract tab.  

33. Click on the Select Contract Project Items… button.  

34. Begin to type 07817[x] into the search bar to initiate search.  

35. Select Project Items 0330 – CSP 24 IN 0.064 and 0340 – CSP 30 IN 0.064 listed under 
Contract 07817[x] – MILK RIVER – NORTH.  

36. Click the Save button.  

37. Click on the Tests tab.  

38. Click the down arrow button next to the Assign Tests button.  

39. Click Assign Default Tests.  

40. Verify that 2 tests were added (MT 202-Sieve Analysis and MT 210, 230-Proctor) 
  



MONTANA DEPARTMENT OF TRANSPORTATION 
AASHTOWare Project Construction and Materials 

 
 

INSPECTOR.docx Updated 9-13-18 Help Desk 1-877-406-4338 Page 33 of 35 

27. Create a sample record for reflective glass beads. 
 
Login 
Username: Uxxxx Password: xxxxxx Role: INSPECTOR 
 
Navigation 
Inspector Links > Sample Records 
 
 
1.   Click on the Component Action button and select Add 

2. In the Material Code field, enter beads and select 714.08.00.01 Reflective Glass Beads 
– Type 1 

3. In the Sample Date field select the current date from the calendar popup 

4. In the Sample Type field select PROJ – Project Acceptance from the dropdown list 

5. In the Acceptance Method field select TEST-Test results from the dropdown list 
6. Click Save 
7. **Make note of the last 4 digits of the Sample ID or the ID itself to use in later test cases 
8. In the Witnessed By ID – Name field select your name from the list 
9. In the Specimen Number field enter 1  
10. In the Intended Use field enter Glass beads for striping 
11. In the District/Area field select BUT – Butte from the dropdown list 
12. In the Control Type field select Batch  
13. In the Control Number field enter 57AB17-5 
14. Click on Save 
15. Click on the Sources Tab  
16. Click on the Select Primary Source button 
17. Click Show first 10 
18. Select Ennis-Flint, Inc (Palestine TX) 
19. Click the Add to Sample Record button 
20. Click Save 
21. Verify that the SMFMI Name label displays a red asterisk indicating it is required 
22. Hit enter in the SMFMI Name field and select Ultralux 
23. Click Save 
24. Select Destination Lab(s) Tab 
25. Click the New button 
26. In the Lab Name field enter butte and select Butte Receiving 
27. Click Save 
28. Click on the Contract tab 
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29. Click the Select Contract Project Items button 
30. In the Search field enter 07817[x] 
31. Click on Select All 
32. Click the Save button 
33. Click on the Tests tab 
34. Click on the arrow to the right of the Assign Tests button and select Assign Default 

Tests 
35. Verify that a District_Received test was added automatically 
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